Foreign Languages and Literatures Program Unveils Redesigned Web Site

Phyllis Galt

In late April, the Foreign Languages and Literatures (FL&L) program launched a redesigned Web site at http://web.mit.edu/fll/www/

The site has a new look, a larger intended target audience, and expanded access to language resources.

The redesign came about in response to a need for a public relations tool aimed at alumni and potential donors. Many FL&L faculty travel extensively and meet with companies, alumni, and colleagues. For this reason, they wanted a dynamic and colorful way to present the FL&L program to those interested in learning more about it – a tool more consonant with the cutting edge pedagogical technology that the FL&L faculty are developing.

Carol Martin, Director of Development for the School of Humanities and Social Sciences, suggested a Web site in lieu of a brochure because of the ease of updating and adding new information. So a decision was made to do a complete redesign of the existing FL&L Web pages (primarily aimed toward students) so that the site could also serve a public relations function. A committee was formed to identify what should be included in the new Web pages that would be of interest to alumni and donors.

The next step was to tackle the new design. FL&L staff were impressed with the Web site of MIT’s Department of Mechanical Engineering at http://me.mit.edu/ and were looking for a similar approach. Three graduate students from Mechanical Engineering – Matthew Wall, Julie Yang, and Ben Linder – produced their department’s Web pages and were eager to design a Web site for FL&L.

The three started work in January of this year and completed a final design within a few months. The new look presents images from a traditional means of communication – a foreign air mail package complete with postage mark, stamps, and labels – with the aim of capturing the flavor of a variety of cultures. These postal images are clickable hotspots; they are used consistently throughout the pages to enhance recognition and aid navigation. In the same vein, a unique background color was assigned to each language area in the FL&L program.

From the Home Page

From the FL&L home page, you can click on a postage stamp to gain access to each language area – Chinese, French, German, Japanese, Spanish, and English as a Second Language. Each area has links to course listings, requirements, and faculty profiles. There are also links to programs and projects, such as the MIT-Germany Program from the German page and the Star Festival from the Japanese page.

continued on page 2
Online Videos Show Students of Japanese How to Write Kanji

The Japanese have three systems for writing language – two based on the sounds of syllables (hiragana and katakana) and one based on pictographs (kanji), where each character is associated with a meaning. The kanji system is difficult to learn due to the sheer number of characters. The Japanese government has defined a list of 1,945 characters, known as Joyo Kanji (Kanji for Daily Use).

Now imagine that you are a student of Japanese. Not only do you have to memorize the meaning of hundreds of kanji, you also need to learn the correct way to write them, step by step. This type of learning is best accomplished by seeing and then copying. Since computers can deliver short video clips on demand, they are uniquely suited to this task. Textbooks can’t come close.

From the bibliography, you can in turn go to the faculty member’s contact information page.

• People. This link takes you to a portrait gallery of the FL&L faculty and staff. Click on a postage-stamp photo to go to a person’s page, which gives contact information and a profile. Some pages also include links to the person’s projects and publications.

• Programs/projects. Programs and projects, grouped by language, are displayed as links on this page. Click on a link to find out about a project’s goals, staff, sponsors, and delivery methods, or to sample some multimedia clips. This page also has a link to the Language Learning and Resource Center.

• Publications. This link takes you to a page of faculty names. When you click on a name, you get a list of that faculty member’s publications.

Other Links
Also from the home page, you can click Overview to get general information about the FL&L program. The familiar “i” (for information) icon takes you to a page about navigating the FL&L pages. The “Priority News” hotspot takes you to timely announcements, such as foreign films playing on campus, and has a link to an extensive list of foreign newspapers and magazines available on the Web.

Software Requirements
The FL&L pages are accessible from any Web browser; however, they have been optimized to be viewed with Netscape 2.0. To view the multimedia clips found throughout the FL&L pages, your system needs to be configured for QuickTime movies and/or MPEG videos.

Getting Help

If the FAQ doesn’t address your question, you can send queries – or your comments and suggestions about the FL&L Web site – to <fll-www@mit.edu>.

Kanji Study Aids
Prof. Saeko Komori of Chubu University in Japan has created nearly 1000 videos showing how individual kanji are written. About 300 of these are now available via JP NET (a Foreign Languages and Literatures clearinghouse for tools, services, and information related to Japanese language and culture). You can get to JP NET at http://www-japan.mit.edu/

To access the videos, go to http://www-japan.mit.edu/mit/mit-materials/KanjiQuiz.html then click on a link for a kanji quiz or a link to review kanji online. This in turn takes you to pages that have images of kanji with colored boxes around them. When you click on one of these images, a movie file is launched which shows that character being painted with a brush. To view these video clips, you need to configure your Web browser with a helper application that can handle movies in .mov format.

© 1996 Massachusetts Institute of Technology
Java is software developed by Sun Microsystems. It consists of an object-oriented language that is somewhat similar in appearance and behavior to C++, and a collection of useful libraries designed around the typical communications and graphics needs of the World Wide Web. Java can be used to create stand-alone programs that are highly portable, but more commonly it is used to create a special type of program called an “applet” that can be run automatically from within Web browsers that support Java.

Web page authors can incorporate Java applets in much the same way that they now incorporate graphic images. When a Web user opens a page that has applets, his or her browser program transfers the code for the applet from the remote Web site and starts running it; when the user leaves the page, the browser automatically stops the applet.

Browser Support for Java
The first Web browser to provide Java support was Sun’s own HotJava. Netscape Navigator is the most popular browser that incorporates Java, at least for the Power Macintosh, Windows 95, Windows NT, Sun Solaris, SGI Irix, and Linux environments. At this time, Mosaic does not support Java. Several companies, including Apple, have licensed the technology for use in browsers and other software.

What Can Applets Do?
Applet possibilities are determined mostly by the imagination of the programmer writing them. You can create applets that generate animated text, provide sound effects, build 3D images, cause the browser to jump to other Web pages, and generally interact with users in a variety of ways. The primary limitation of applets is that, for security reasons, they aren’t allowed to perform certain kinds of communications activities or local file access. Stand-alone Java programs don’t have these security limitations unless the programmer chooses to include them.

Security Issues
Sun, the various vendors of Web browser software, and interested Java users around the world are all working to find any weaknesses and correct them to make Java as secure as possible. In the meantime there are some security holes that could be exploited. To find out more, see the Security FAQ at http://java.sun.com/sfaq/

You can configure your browser so that Java applets aren’t executed automatically. (The way you do this in Netscape depends on the version of the browser you’re using. Either go to the Options menu and select Network Preferences, then Languages or go to the Options menu and select Security, then General. You will see checkboxes to enable Java and JavaScript [more on JavaScript later]. Make sure the checkboxes are not selected.) You can turn Java or JavaScript back on when there’s an applet or script you want to run. The safest course is to view applets from people or sources that you trust.

Java Programming
Is it easy to write Java applets? Not really. If you are an accomplished programmer in a major language like C, Basic, or Pascal, you will be able to pick up the basics of Java. If you have written object-oriented programs in something like C++, you’ll find it even easier. Even so, after a certain point you’ll find that there are some subtle but very important aspects of the language and libraries that can be tricky to master unless you have experience in a broad range of programming disciplines, including computer graphics, object-oriented design, concurrency, network programming, and transaction processing.

Using Applets
While Java programming is not for everyone, Web page authors can use Java applets that others have written. There is a growing body of reusable utility applets that authors can adapt to their own needs. Including these in Web pages isn’t much more difficult than writing HTML. For example, Sun staff members wrote an Animator applet that can be used to display a collection of GIF images as a continuous animation. You don’t have to write any Java code to use this applet; you just write your Web page to load the applet and tell it where to find the GIF files. You can find a beta version of the Animator applet at http://java.sun.com/JDK-1.0.1/demo/Animator/

The JavaScript Connection
If you’ve heard of Java, you’ve probably also heard of JavaScript. However, the two aren’t that closely related. Originally JavaScript was a Web scripting language called LiveScript that Netscape was developing. With the popularity of Java, Netscape changed the syntax of their language to match Java syntax. There is some limited ability for JavaScript scripts and Java applets to interact, but that is really the only tie between the two. JavaScript is currently considered to be much less secure than Java.

Learning More
You can find a lot of useful information about Java and JavaScript on the World Wide Web and in books. Check out the following URLs:

- The official Sun site for Java http://java.sun.com/
- A large index of Java and JavaScript materials http://www.gamelan.com/
- A local collection of Java-related information, including a book list http://web.mit.edu/javalib/www/home.html
- A local collection that shows what types of programs can be written in Java http://web.mit.edu/katiel/www/demo.html

In addition, there’s a Java mailing list on Athena at java-hackers@mit.edu. The transactions of this mailing list are archived in a Discuss meeting on Charon.
Copyright Act Before Congress Could Impact Education

Joanne Costello

In recent weeks, the media has focused on potential U.S. trade sanctions against China. These sanctions are meant to pressure the Chinese government into enforcing laws that protect copyrights.

While not grabbing headlines in the same way, copyright measures now before Congress could have a critical impact on education and Internet use. As in the trade maneuverings with China, business interests are playing a major part: the recommendations on which the Copyright Protection Act of 1995 is based come from a Commerce Department working group.

While the drafters of these recommendations say that they “fine tune” copyright law for the digital age, critics believe that the Copyright Protection Act of 1995 threatens online browsing and fair use.

Copyright in Cyberspace

The original Copyright Act of 1909 balanced the individual’s property rights with the public’s need for creativity in the arts and sciences. Usage fees were charged and distributed to creators and publishers.

New technology has made this system inadequate. How do we monitor usage and charge a fee? The World Wide Web makes capturing information, images, and sound incredibly easy. Once material (copyrighted or not) is in electronic form, anyone can reproduce and distribute it, without its creator’s knowledge or consent.

In addition, current law is based on being able to distinguish easily among creator/producer, publisher/distributor, and user. Today you can wear all of these hats at the same time.

Working Group Report


This 250-page report is not easy to understand: it was written by lawyers for lawyers. Although the report characterizes recommended changes as “no more than minor clarification and limited amendment” to the copyright statute, critics claim that it proposes a major shift in the balance struck by current copyright law.

Current Status, Current Views

The Copyright Protection Act of 1995 – based on the working group’s report – was introduced in the House of Representatives on September 28, 1995. Voting on the bill is expected any day.

Critics feel that the Copyright Protection Act is dominated by business concerns, without adequate regard for educators, students, and researchers. Libraries and universities have been the harshest critics of the bill.

In an attempt to protect the rights of publishers, the proposed Copyright Protection Act limits rights to electronic information. Digital transmission of a copyrighted work by anyone but the copyright owner would constitute infringement. This effectively eliminates the right to browse the Web, since the only way to look at a Web-based file is to transmit a copy to your computer.

Educators and researchers are also concerned about extending fair use rights to networks. These rights enable teachers to make limited copies of copyrighted material to distribute in classes without the explicit permission of copyright owners, and give researchers a reasonable degree of access to source materials. These rights may be lost if the Copyright Protection Act is strictly applied.

For an in-depth look at how educators and network activists view the Copyright Protection Act, go to http://www.eff.org/pub/Alerts/i-p and http://www.arl.net/dfc/info/Copyright.html.

I will be typing some foreign language documents, and want to include diacritical marks – accents, cedillas, umlauts, and carets. Can I do this using a word processing program?

A Yes. Both Microsoft Word and WordPerfect let you type foreign language characters. Position the insertion point where you want the character to appear, then follow one of the procedures below. The character will be inserted into the text, in the current text font.

Microsoft Word: Symbol Palette

1. Go to the Insert menu and select Symbol... In Word 6, be sure that (normal text) is selected in the Font menu.

2. Double-click on the desired character.

   You may leave the Symbol palette open, to move quickly between it and your document.

Microsoft Word: Shortcut Keys

1. Select one of the diacritical marks below by holding down the Option key on the Macintosh or the CTRL key in Windows and pressing the corresponding key in the chart; release both keys.

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option+ E</td>
<td>CTRL+ '</td>
</tr>
<tr>
<td>Option+ '</td>
<td>CTRL+ '</td>
</tr>
<tr>
<td>Option+ U</td>
<td>CTRL+ :</td>
</tr>
<tr>
<td>Option+ I</td>
<td>CTRL+ ^</td>
</tr>
<tr>
<td>Option+ N</td>
<td>CTRL+ ~</td>
</tr>
</tbody>
</table>

2. Press the key for the character to which the diacritical is attached; hold down the Shift key for uppercase. For example, to get Ò on the Mac, press Option+N, then Shift+O.

WordPerfect: Character Set Menu

1. From the Insert menu, select Character.

2. In the Character Set menu, select Multinational.

3. Double-click on the desired character.
Reengineering-Recommended Systems for Spring 1996

Ginny Williams

Many administrative applications at MIT require the power and graphical capabilities of more recent desktop computers. By buying recommended systems, you’ll be able to take full advantage of today’s applications and share work more easily with colleagues. Use of recommended systems also holds down training and support costs, and helps in planning equipment renewal cycles.

Both of the Spring ’96 recommended systems are fully compatible with MITNet and MIT’s supported network applications, such as electronic mail and remote access. Two printers have also been recommended.

The MCC has placed orders for these systems and printers so that they will be available for departments that want to use FY ’96 funds. The deadline for orders is June 10 (see the box below).

The Spring ’96 recommendations include a Windows and a Macintosh system:

- **Dell Optiplex 5100/GXL with a 100MHz Pentium processor.** This system has been enhanced to include integrated 3COM 10BaseT Ethernet and integrated sound. It has three slots and two bays, 16MB RAM, a 1GB hard drive, and a 4x CD-ROM. It comes with a 15” Dell LS color monitor and a Spacesaver keyboard.

- **Power Macintosh 7500/100.** This system features a 100MHz PowerPC 601 processor that is upgradeable to the new 604 chip, built-in 10BaseT and AAUI Ethernet, and accelerated video with 2MB VRAM. It has three PCI slots, 16MB RAM (expandable to 512MB), a 1GB hard drive, and a 4x CD-ROM. Keyboard and display are sold separately. (Speak with an MCC sales consultant about display options).

Selected Printers

The two reengineering-approved printers are both from Hewlett-Packard:

- **HP LaserJet 5Si MX.** This model prints 24 pages per minute (ppm) at 600 dots per inch (dpi), has 12MB RAM, two 500-sheet paper trays, and one 100-sheet multipurpose tray. It features Adobe Postscript Level 2 and HP PCL 5 page description, HP JetDirect Ethernet/LocalTalk, and parallel interfaces. A duplex option is available separately.

- **HP LaserJet 4MV.** This model prints up to 16 ppm at 600 dpi, and comes with 12MB RAM and two paper trays. It features Adobe Postscript Level 2 and HP PCL 5 page description, HP JetDirect Ethernet/LocalTalk, and parallel interfaces.

**Attention, Institute Customers!**

Fiscal Year ’96 is drawing to a close. If you plan to buy items from the MCC and want to pay for them with your FY ’96 budget, please keep the following deadlines in mind:

- **For reengineering-recommended systems.** Departmental orders must be received at the MCC no later than June 10, 1996.

- **For in-stock items that you want delivered to an MIT office.** The MCC must receive your requisition by June 19, 1996.

- **For in-stock items that you will pick up.** The MCC must receive your requisition by June 21, 1996.

These deadlines may affect your ability to buy special-order items using FY ’96 funds, since delivery times on special-order items vary. If you’re not sure about the availability of a product, contact the MCC at x3-7686 or <mcc@mit.edu>.

**For More Information**

For pricing and other information on the reengineering-recommended systems and printers, call x3-7686. The MCC also sells upgrades and alternative products.

---

The Best of Both: Power Macs with PC Compatibility Cards

It sounds too good to be true – a Macintosh and a PC in one box – but Apple has worked hard at perfecting a true dual-processor system. The key is Apple’s new PC Compatibility Card, which works in PCI-based Power Macs. The card comes in two configurations:

- a Pentium 100MHz processor with 256K level 2 cache and 8MB RAM (expandable to 72MB) on a 12-inch card
- a 586 100MHz processor with 128K level 2 cache and 8MB RAM (expandable to 64MB) on a 7-inch card

These cards let you run DOS and Windows applications directly, without software emulation. With a single keystroke, you can switch between the Mac OS, Windows, and DOS. You can even run PC and Macintosh applications concurrently, which lets you cut and paste between environments, and share folders, drives, and diskettes.

The PC Compatibility Cards work with the Power Macintosh 7200, 7500, 7600, 8500, 9500, and 5400/120 systems, all Apple displays, and most VGA and SVGA displays. You can print to Macintosh-compatible printers, and take advantage of network services over Novell NetWare SPX/IPX, TCP/IP, and NETBEUI protocols in the DOS and Windows environment. You can even run DOS/Windows multimedia applications using the card’s built-in support for Sound Blaster-16.

The cards are user-installable, and include MS-DOS 6.22. They are compatible with Windows 3.11, Windows for Workgroups 3.11, and Windows 95.

**For More Information**

For pricing and ordering information, contact the MCC at x3-7686 or <mcc@mit.edu>, or view the MCC Web site at http://web.mit.edu/mcc/www.
Guidelines for Purchasing a Site License at MIT
IS Contracts Team

Site licenses for software have the potential to save your department and MIT money. However, negotiating and administering such licenses can require a significant amount of effort. So how do you evaluate whether a site license is worth your while? What steps do you need to take? And what Institute resources are available?

To answer these questions, let’s consider a sample scenario. You’re a systems administrator who has paid $1000 apiece for licenses to run a sophisticated CAD package on five computers in your lab. Now the vendor tells you that for $5000 more you could buy an MIT-wide site license (which would include, of course, all the computers in your department). You speak to a colleague in another department, who offers $3000 towards the deal, but you still need someone to fund the other $2000.

Assessing the Deal

If you were the systems administrator in this scenario, what should your next step be? Quite simply, to find out as much about the deal as possible.

Review the terms closely to make sure that the site license will actually save money. Sometimes the deal is well worth it. Vendors often offer educational pricing because they want MIT students to use the software or want MIT on their customer list. However, you may find that the $10,000 site license fee is an annual fee, and that you already own a perpetual license for your five licenses for which you are paying only $1500 dollars per year in maintenance. Or you may find that the educational pricing excludes use of the software for sponsored research or administrative purposes.

You should also review the non-financial aspects of the deal. For example, while the CAD software runs in your local environment, you may also need to take into account MIT infrastructure issues. For details, see http://web.mit.edu/reeng/www/ready/requirements.html

Further, under many site licenses, the vendor ships only one set of media and documentation, and limits the number of contact people. You may need to think about finding resources to duplicate and distribute the software and documentation, and filter technical questions through a single MIT technical liaison.

The “10 Key Site License Questions” sidebar on page 7 provides more in-depth guidance on assessing the deal. If, after your initial conversations, the deal still seems viable, ask the vendor to send you a price quote, the software license, and any other paperwork.

Assembling Contributors

Let’s assume that the vendor’s deal on the CAD software is a fair one. How do you pull the resources together to make the purchase?

Information Systems (IS) does not have the staff or resources to coordinate the financing of all software site licenses or to administer all of them. Therefore, you must take the initiative to identify other contributors. You need to determine who will pay for the license, who will coordinate the purchase, and who will take on administrative and technical responsibilities. Since most site licenses require that you pay yearly maintenance or an annual fee, this coordination effort may be required each year. If you’re sharing these responsibilities with another person or department, you should agree on each party’s contribution and role.

Possible contributors for your CAD site purchase might include:
- Others in your group or department
- Other interested departments
- One of the Directors in IS

The type of software and its usefulness to other departments at MIT is a good starting point for determining who the contributors could be. If the CAD package is used almost exclusively as an aid to architectural drawing, interest may be limited to the Department of Architecture. If the CAD package has real or potential widespread utility, IS may contribute to the purchase, administration, and distribution of the site license.

Depending on the nature of the software, you can contact one of three individuals to see if IS might contribute:
- Diane Devlin, Director of Office Computing
- Vijay Kumar, Director of Academic Computing
- Susan Minai-Azary, Director of Information Technology Integration

Upon reviewing the product and potential deal, the appropriate IS Director may commit IS funds towards the purchase of the license and arrange for IS assistance in distributing the software or administering the license. In this example, the Director of Academic Computing might contribute funds to the purchase and arrange to make the CAD package available on Athena. (Note: If you want software to be available on Athena, you need to speak with the Director of Academic Computing or the Athena representative on the Contracts Team, even if you aren’t seeking Athena financing.)

Even when other departments act as the primary contributors, IS may help distribute the software by placing it on an IS server such as net-dist. All IS decisions related to funding and distribution are made on a case-by-case basis and are reviewed annually.

<table>
<thead>
<tr>
<th>Service</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assistance with license agreements and compliance</td>
<td><a href="mailto:contracts@mit.edu">contracts@mit.edu</a> x3-8613 academic computing/Athena x3-1348 research/other computing</td>
</tr>
<tr>
<td>Information about existing site licenses</td>
<td><a href="mailto:contracts@mit.edu">contracts@mit.edu</a> x3-1348</td>
</tr>
<tr>
<td>Information about placing software on Athena</td>
<td><a href="mailto:alexp@mit.edu">alexp@mit.edu</a> x3-8613</td>
</tr>
<tr>
<td>IS Software Libraries (DEC, HP, SGI, Sun)</td>
<td><a href="mailto:help@isis.mit.edu">help@isis.mit.edu</a> x3-6320</td>
</tr>
<tr>
<td>Requests to IS Directors: Academic Computing Office Computing Information Technology Integration</td>
<td><a href="mailto:vkumar@mit.edu">vkumar@mit.edu</a> x3-8004 <a href="mailto:ddevlin@mit.edu">ddevlin@mit.edu</a> x3-8181 <a href="mailto:azary@mit.edu">azary@mit.edu</a> x3-7013</td>
</tr>
</tbody>
</table>
Also keep in mind that the vendor can often help in assembling contributors. The vendor representative may be willing to find other MIT prospects and combine your purchase with theirs, or may be willing to credit recently paid individual license fees toward the site license fee. The vendor may also be able to simplify the license administration responsibilities – for example, by allowing each department to receive its own set of media and documentation, and to have its own technical contacts.

Closing the Deal

Once you’ve decided to obtain a site license and have assembled those who will pay for it, you need to send the license agreement and all supporting paperwork to the IS Contracts Team. The Contracts Team draws on people from several areas of IS who review and negotiate the legal, business, and technical aspects of software licenses. The team handles all license agreements and software order forms that require a signature. Team members ensure that the terms of the agreement match the terms agreed upon by you and the vendor, and that they are consistent with the MIT environment, your intended use of the software, and Institute policy.

After negotiating the license agreement, the Contracts Team will have the license signed by one of the few senior officers authorized to sign such contracts for MIT, and will forward the paperwork and requisition to Purchasing. The Contracts Team will advise you on administration and compliance, and provide ReadMe files or other required notices when appropriate.

You can expedite completion of these three steps – assessing the deal, assembling contributors, and closing the deal – by pursuing them in parallel. When you begin exploring a deal, for instance, the Contracts Team can inform you of any similar products available under existing MIT site licenses. Early on, the team can also help you evaluate the deal and identify problematic clauses in the license.

MIT has already negotiated several software site licenses. IS makes some of this software available to the MIT community at no charge and other software available at a discount, through network distribution, the Athena Computing Environment, the MIT Computer Connection, and IS Software Libraries.

---

### 10 Key Site License Questions

1. **Who will use this product?**
   - A vendor may define “site” to mean a single building, a single department, or the entire Institute. MIT may need to add wording to allow for home use or for use at Lincoln Laboratories, Woods Hole, or another MIT affiliate. Most license agreements need to be modified to permit use by faculty, students, consultants, or anyone outside of MIT.

2. **Are any similar products already site licensed by MIT?**
   - You may want to check with the contacts listed in the chart on p. 6 to see if there is an existing site-licensed product at the Institute that meets your requirements.

3. **What kind of license is it?**
   - The license may be a perpetual license or one for a limited period of time. If the license is perpetual, MIT will have the right to continue using the latest-received version of the software even if MIT cancels maintenance/support. It is important to find out if the annual fee is a license fee or a maintenance/support fee.
   - The license may allow for an unlimited number of users or may restrict the number of people and/or CPUs accessing the software.

4. **Are there any restrictions on use?**
   - Licenses for “teaching purposes” may exclude use for research; licenses that cannot be used “for any commercial purpose” need to be negotiated to allow use for commercially sponsored research.

5. **What are the total initial costs of the site license? Where will funds come from?**
   - If several groups are splitting the cost, they must decide what each group will contribute and who will coordinate the requisition(s). While several groups may be interested, the amount of money they are willing to contribute may fall short of the total cost.

6. **Are there annual license or maintenance/support fees?**
   - Several groups may be sponsoring the site license, but may not be willing to split the fees each year. If some decide not to renew their license or maintenance, then the others may end up paying more in subsequent years than they had originally planned.

7. **How will MIT provide technical support?**
   - The vendor may require MIT to channel support calls through a small number of technical contacts. In some cases, individual users may contact the vendor directly.

8. **Does the site license have administrative requirements? Who will fulfill them?**
   - Some licenses require MIT to count CPUs or keep track of serial numbers. Others include software protection mechanisms (e.g., a node lock or license manager) which may make installation and updating difficult or make it impossible to run the software satisfactorily on Athena.

9. **How will the software be distributed?**
   - MIT may be entitled to only one copy of the media and may be expected to copy the software and distribute it to each user. Some licenses also prohibit network distribution. Sometimes individuals can order media copies directly from the vendor.

10. **How many copies of documentation is MIT entitled to?**
    - Each department may have to buy its own copies. Or MIT may have the right to make unlimited copies and/or place the documentation in electronic form on MITnet.

These issues can always be negotiated. For help in assessing a deal or interpreting and negotiating a site license, send your queries to <contracts@mit.edu> or call x3-1348.
If you don’t know where to get help for your computer, network, or telephone problems, call the IS Help Line, x3-2001 – or direct dial one of the help lines listed to the right.

If you prefer to use electronic mail, you can send your questions to the corresponding addresses on the far right. (When logged into Athena, you can also use the olc command to send questions to Athena’s online consultants.)

<table>
<thead>
<tr>
<th>For help with...</th>
<th>Dial...</th>
<th>Or send a message to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Athena Computing Environment</td>
<td>3-4435</td>
<td><a href="mailto:olc@mit.edu">olc@mit.edu</a></td>
</tr>
<tr>
<td>Athena hardware repairs</td>
<td>3-1410</td>
<td><a href="mailto:hotline@athena.mit.edu">hotline@athena.mit.edu</a></td>
</tr>
<tr>
<td>Computer sales</td>
<td>3-7686</td>
<td><a href="mailto:mcc@mit.edu">mcc@mit.edu</a></td>
</tr>
<tr>
<td>DEC and Sun software</td>
<td>3-6320</td>
<td><a href="mailto:help@isis.mit.edu">help@isis.mit.edu</a></td>
</tr>
<tr>
<td>Disabilities and computing</td>
<td>3-7808</td>
<td><a href="mailto:atic@mit.edu">atic@mit.edu</a></td>
</tr>
<tr>
<td>IS mainframes</td>
<td>3-7230</td>
<td><a href="mailto:mithelp@mit.edu">mithelp@mit.edu</a></td>
</tr>
<tr>
<td>Microcomputer and printer repairs</td>
<td>3-0815</td>
<td><a href="mailto:pcservice@mit.edu">pcservice@mit.edu</a></td>
</tr>
<tr>
<td>Microcomputer use</td>
<td>3-0001</td>
<td><a href="mailto:micro-help@mit.edu">micro-help@mit.edu</a></td>
</tr>
<tr>
<td>Networks/MITnet</td>
<td>3-4101</td>
<td><a href="mailto:net-help@mit.edu">net-help@mit.edu</a></td>
</tr>
<tr>
<td>Telephone repairs</td>
<td>3-4357</td>
<td><a href="mailto:5help@mit.edu">5help@mit.edu</a></td>
</tr>
<tr>
<td>Voice mail</td>
<td>3-3677</td>
<td><a href="mailto:vmail@mit.edu">vmail@mit.edu</a></td>
</tr>
</tbody>
</table>

Foreign Language Resources on the World Wide Web

Foreign language resources have found a natural home on the World Wide Web, given its global reach. To the right is a list of language-related Web sites, starting with the homepage of MIT’s Foreign Languages and Literatures program. Other sites focus on foreign newspapers and magazines, language lessons (with audio files), translating dictionaries, and foreign culture and travel.

MIT Foreign Languages and Literatures
http://web.mit.edu/fll/www/

Foreign Newspapers and Magazines

The Human-Languages Page
http://www.willamette.edu/~tjones/Language-Page.html

Foreign Languages for Travelers
http://www.travlang.com/languages/

Communication Connections
http://www.widomaker.com/~ldprice/

U.S. State Department Travel Warnings and Consular Information Sheets
http://www.stolaf.edu/network/travel-advisories.html

Foreign language resources have found a natural home on the World Wide Web, given its global reach. To the right is a list of language-related Web sites, starting with the homepage of MIT’s Foreign Languages and Literatures program. Other sites focus on foreign newspapers and magazines, language lessons (with audio files), translating dictionaries, and foreign culture and travel.

MIT Information Systems

Nonprofit Organization
U.S. Postage
P A I D
Cambridge, MA
 Permit No. 54016

i/s is printed with soy inks on recycled paper, and can be recycled in MIT’s “white paper only” bins.